Layers, Colors, and Linetypes

COMMANDS

CHAMFER  LAYER  PAN  REGEN
FILLET    LTSCALE PLOT  ZOOM

OVERVIEW

CAD is much more than a computerized way to do drafting. CAD programs have many powerful features that have no correlation in manual drawing. Layering is a good example. Layers exist in the same space and the same drawing, but can be set up and controlled individually, allowing for greater control, precision, and flexibility. In the first two chapters, all of your drawings were completed on a single layer called 0. In this chapter, you create and use three new layers, each with its own associated color and linetype.

The ZOOM command is another bit of CAD magic, allowing your drawings to accurately represent real-world detail at the largest and smallest scales within the same drawing. In this chapter, you also learn to FILLET and CHAMFER the corners of previously drawn objects and to move between adjacent portions of a drawing with the PAN command. You gain further control of the PLOT command by using partial and full previews. All of these new techniques add considerably to the professionalism of your developing CAD technique.

TASKS

3.1 Creating New Layers
3.2 Assigning Colors to Layers
3.3 Assigning Linetypes
3.4 Assigning Lineweight
3.5 Changing the Current Layer
3.6 Editing Corners Using FILLET
3.7 Editing Corners Using CHAMFER
3.8 Using the ZOOM Command
3.9 Zooming and Panning with the Scroll Wheel
3.10 Using Realtime ZOOM and PAN
3.11 Using Plot Preview
3.12 Review Material  
3.13 WWW Exercise 3 (Optional)  
3.14 Drawing 3-1: Mounting Plate  
3.15 Drawing 3-2: Stepped Shaft  
3.16 Drawing 3-3: Base Plate  
3.17 Drawing 3-4: Bushing  
3.18 Drawing 3-5: Half Block  
3.19 Drawing 3-6: Packing Flange

3.1 Creating New Layers

GENERAL PROCEDURE

1. Select the Layer Properties Manager tool from the Object Properties toolbar or Layer from the Format pull-down menu.
2. Click the New layer icon.
3. Type in a layer name.
4. Repeat for other new layers.
5. Click OK to close the dialog box.

Layers allow you to treat specialized groups of entities in your drawing separately from other groups. For example, all of the dimensions in this book were drawn on a special dimension layer so that we could turn them on and off at will. We turned off the dimension layer to prepare the reference drawings for Chapters 1 through 7, which are shown without dimensions. When a layer is turned off, all the objects on that layer become invisible, although they are still part of the drawing database and can be recalled at any time. In this way, layers can be viewed, edited, manipulated, and plotted independently.

It is common practice to put dimensions on a separate layer, but there are many other uses of layers as well. Fundamentally, layers are used to separate colors and linetypes, and these, in turn, take on special significance, depending on the drawing application. It is standard drafting practice, for example, to use small, evenly spaced dashes to represent objects or edges that would, in reality, be hidden from view. On a CAD system, these hidden lines can also be given their own color to make it easy for the designer to remember what layer he or she is working on.

In this book, we use a simple layering system, most of which is presented in this chapter. You should remember that there are countless possibilities. AutoCAD allows a full range of colors and as many layers as you like.

You should also be aware that linetypes and colors are not restricted to being associated with layers. It is possible to mix linetypes and colors on a single layer. Although this might be useful for certain applications, we do not recommend it at this point.

Open a new drawing by typing new or selecting New from the File menu.

Check to see that acad is in the File name box and press Enter.

Press F7 to turn on the grid.

Type z to enter the ZOOM command and then a to zoom all.

The Layer Properties Manager Dialog Box

The creation and specification of layers and layer properties in AutoCAD is handled through the Layer Properties Manager dialog box. This dialog box consists of
Chapter 3  Layers, Colors, and Linetypes

Figure 3-1

a table of layers. Clicking the appropriate row and column changes a setting or takes you to another dialog box where a setting can be changed.

Select the Layer Properties Manager tool from the Object Properties toolbar, as shown in Figure 3-1, or select Layer from the Format pull-down menu.

Either method opens the Layer Properties Manager dialog box illustrated in Figure 3-2. The large open space to the right shows the names and properties of all layers defined in the current drawing. Layering systems can become very complex, and for this reason there is a system to limit or filter the layer names shown on the layer list. This is controlled by the icons at the top left. With no filters specified, the layer list shows all used layers. Currently, 0 is the only defined layer. The icons on the line after the layer name show the current state of various properties of that layer. We get to these shortly.

Now we will create three new layers. AutoCAD makes this easy.

Click the New layer icon, just above the top left of the layer list.

A newly defined layer, Layer1, is created immediately and added to the Layer name window. The new layer is given the characteristics of layer 0. We alter these in Task 3.2. First, however, we give this layer a new name and then define three more layers.

Figure 3-2
Layer names can be long or short. We have chosen single-digit numbers as layer names because they are easy to type and we can match them to AutoCAD’s index color numbering sequence.

1. Type 1 for the layer name.
   Layer1 changes to simply 1. It is not necessary to press Enter after typing the name.
2. Click the New layer icon again.
   A second new layer is added to the list. It again has the default name Layer1. Change it to 2.
3. Type 2 for the second layer name.
4. Click the New layer icon again.
5. Type 3 for the third layer name and press Enter to complete the process.
   At this point, your layer name list should show Layers 0, 1, 2, and 3, all with identical properties.

3.2 Assigning Colors to Layers

GENERAL PROCEDURE

1. Select the Layer Properties Manager tool from the Object Properties toolbar, or select Layer from the Format menu.
2. Click the color icon on the row for the layer you want to change.
3. In the Color dialog box, select a color from the index color chart or type a color name or number in the edit box.
4. Click OK.

We now have four layers, but they are all pretty much the same. Obviously, we have more changes to make before our new layers have useful identities.

Layer 0 has some special features, which are discussed in Chapter 10. Because of these, it is common practice to leave it defined the way it is. We begin our changes on Layer 1.

If for any reason you have closed the Layer Properties Manager dialog box, reopen it by selecting the Layer Properties Manager tool from the Object Properties toolbar or Layer from the Format menu.

Move the cursor arrow to the Layer 1 line and click the white square under Color.

Clicking the white square in the color column of Layer 1 selects Layer 1 and opens the Select Color dialog box illustrated in Figure 3-3. The three tabs in this dialog box show three ways in which colors can be defined in AutoCAD. By default, the Index Color tab is probably selected, as shown in Figure 3-3. The index color system is a simple numbered selection of 255 colors and shades. The True Color and Color Books systems are standard color systems commonly used by graphic designers. The True Color tab can be set to access either the Hue, Saturation, and Luminance (HSL) color model or the Red, Green, and Blue (RGB) model. Both of these systems work by mixing colors...
Figure 3-3

and color characteristics. The Color Books tab gives access to Pantone and RAL color books. These standard color sets are also numbered, but they provide many more choices than the AutoCAD index color set. In this book we confine ourselves to the Index Color tab.

- If necessary, click the Index Color tab.

The Index Color tab shows the complete selection of 255 colors. At the top is a full palette of shades 10 through 249. Below that are the nine standard colors, numbered 1 through 9, followed by gray shades, numbered 250 through 255.

- Move your cursor freely inside the dialog box.

  When your cursor is on a color, it is highlighted with a white box.

- Let your cursor rest on any color.

  Notice that the number of the color is registered under the palette next to the words Index color. This is the AutoCAD index color number for the color currently highlighted. Notice also the three numbers on the right following the words Red, Green, Blue. This is the RGB color model equivalent. RGB colors are combinations of red, green, and blue, with 255 shades of each.

- Left-click to select any color in the palette.

  When a color is selected, it is outlined with a black box and a preview “patch” is displayed on the bottom right of the dialog box against a patch of the
current color for comparison. The color is not actually selected in the drawing
until you click OK to exit the dialog box. For our purposes, we want to select
standard red, color number 1 on the strip in the middle of the dialog box.

- Move the white cursor box to the red box, the first of the nine stan-
dard colors in the middle of the box.

  Notice that this is index color number 1 and its RGB equivalent is 255, 0, 0,
pure red with no green or blue added.

- Select the red box.

  You should see the word red and the color red shown in the preview area
at the bottom of the dialog box. Note that you can also select colors by typing
names or numbers directly in this edit box. Typing red or the number 1 is the
same as selecting the red color box from the chart.

- Click OK.

  Layer 1 is now defined with the color red in the Layer Name list box.

  Next we assign the color yellow to Layer 2.

- Click the white square under Color in the Layer 2 line and assign the
color yellow to Layer 2 in the Select Color dialog box.

- Click OK.

- Select Layer 3 and set this layer to green.

  Look at the layer list. You should now have Layers 0, 1, 2, and 3 defined
with the colors white, red, yellow, and green.

### 3.3 Assigning Linetypes

**GENERAL PROCEDURE**

1. Select the Layer Properties Manager tool from the Object Properties toolbar or Layer
   from the Format menu.
2. Click in the Linetype column of the layer you want to set.
3. In the Select Linetype dialog box, select a linetype. If necessary, load linetypes first.
4. Click OK.
5. Click OK again to exit the dialog box.

AutoCAD has a standard library of linetypes that can easily be assigned to layers.
There are 45 standard types in addition to continuous lines. In addition to continuous
lines, we use hidden and center lines. We put hidden lines in yellow on Layer 2
and center lines in green on Layer 3. Layers 1 and 0 retain the continuous linetype.

The procedure for assigning linetypes is almost identical to the procedure for as-
signing colors, except that you have to load linetypes into the drawing before they
can be used.

- If for any reason you have closed the Layer Properties Manager, re-
  open it by selecting the Layer Properties Manager tool from the Object
  Properties toolbar.

- Click Continuous in the Linetype column of the Layer 2 line.
Chapter 3  Layers, Colors, and Linetypes

Note: Make sure that you actually click the word Continuous. If you click one of the icons in the Layer 2 line, you might turn the layer off or freeze it so that you cannot draw on it. These properties are discussed at the end of Task 3.5.

This selects Layer 2 and opens the Select Linetype dialog box illustrated in Figure 3-4. The box containing a list of loaded linetypes currently only shows the continuous linetype. We can fix this by clicking Load at the bottom of the dialog box.

- Click Load.

This opens a second dialog box, the Load or Reload Linetypes dialog box illustrated in Figure 3-5. Here you can pick from the list of linetypes available from the standard acad file or from other files containing linetypes, if there are any on your system. You also have the option of loading all linetypes from any given file at once. The linetypes are then defined in your drawing, and you can assign a new linetype to a layer at any time. This makes things easier. It does, however, use up more memory.

For our purposes, we load only the hidden and center linetypes we are going to be using.

- Scroll down until you see the Center linetype.
- Click Center in the Linetype column at the left.
- Scroll down again until you see the Hidden linetype on the list.
- Hold down the Ctrl key and click Hidden in the Linetype column.
  - The Ctrl key lets you highlight two separate items in a list.
- Click OK to complete the loading process.

You should now see the center and hidden linetypes added to the list of loaded linetypes. Now that these are loaded, we can assign them to layers.
1. Select the Layer Properties Manager tool from the Object Properties toolbar or Layer from the Format menu.
2. Click the Lineweight column of the layer you want to change.
3. In the Lineweight dialog box, select a lineweight.
4. Click OK.
5. Click OK again to exit the dialog box.

Figure 3-5

Click Hidden in the Linetype column.
Click OK to close the dialog box.
You should see that Layer 2 now has the hidden linetype.
Next assign the center linetype to Layer 3.
Click Continuous in the Linetype column of the Layer 3 line.
In the Select Linetype dialog box, select the Center linetype.
Click OK.
Examine your layer list again. It should show Layer 2 with the hidden linetype and Layer 3 with the center linetype. Before exiting the Layer Properties Manager, we create one additional layer to demonstrate AutoCAD’s lineweight feature.

3.4 Assigning Lineweight

**GENERAL PROCEDURE**

1. Select the Layer Properties Manager tool from the Object Properties toolbar or Layer from the Format menu.
2. Click the Lineweight column of the layer you want to change.
3. In the Lineweight dialog box, select a lineweight.
4. Click OK.
5. Click OK again to exit the dialog box.
Lineweight refers to the thickness of lines as they are displayed and plotted. All lines are initially given a default lineweight. Lineweights are assigned by layer and are displayed only if the LWT button on the status bar is in the on position. In this task, we create a new layer and give it a much larger lineweight for demonstration purposes.

- If for any reason you have left the Layer Properties Manager dialog box, reopen it by selecting the Layer Properties Manager tool from the Object Properties toolbar.
  
  First, we create a new layer because we do not want to change our previous layers from the default lineweight setting.

- If Layer 3 is not highlighted, highlight it by pointing to the name 3 and pressing the pick button.

- Click the New layer icon in the dialog box.

  Notice that the new layer takes the characteristics of the previously highlighted layer. Our last action was to give Layer 3 the center linetype, so your new layer should have green center lines and the other characteristics of Layer 3.

- Type 4 for the new layer name and press Enter.

- Click Default in the Lineweight column of Layer 4.

  This opens the Lineweight dialog box, shown in Figure 3-6. We use a rather large lineweight to create a clear demonstration.
Part I Basic Two-Dimensional Entities

Figure 3-7

Scroll down until you see 0.50 mm on the list.
Highlight the 0.50 mm line.
Below the list you can see that the original specification for this layer was the default and is now being changed to 0.50 mm.
Click OK to return to the Layer Properties Manager.
It is now time to leave the dialog box and see what we can do with our new layers.
Click OK to exit the Layer Properties Manager.

Note: Do not exit the dialog box by clicking the close button. Exit only by clicking OK. If you use the close button, or if you cancel the dialog box, all of your changes, new layers, and so on, will be lost.
Before proceeding, you should be back in your Drawing Window with your new layers defined in your drawing. To verify that you have successfully defined new layers, open the Layer drop-down list on the Object Properties toolbar, as shown in Figure 3-7.
To open the Layer list, click anywhere in the list box.
Your list should resemble the one in Figure 3-7.

3.5 Changing the Current Layer

GENERAL PROCEDURE
1. Open the Layer list from the Object Properties toolbar.
2. Select a layer name.
or
1. Select the Make Object’s Layer Current tool from the Object Properties toolbar.
2. Select an object on the layer you wish to make current.

In this task, we make each of your new layers current and draw objects on them. You can immediately see how much power you have added to your drawing by the addition of new layers, colors, linetypes, and lineweight.
To draw new entities on a layer, you must make it the currently active layer. Previously drawn objects on other layers that are turned on are also visible and plotted, but new objects go on the current layer.
There are two quick methods to establish the current layer. The first works the same as any drop-down list. The second makes use of previously drawn objects. We use the first method to draw the objects in Figure 3-8.

- Click anywhere in the Layer list box on the Object Properties toolbar.
  This opens the list, as shown previously in Figure 3-7.
- Select Layer 1 by clicking to the right of the layer name 1 in the drop-down list.
  Layer 1 replaces Layer 0 as the current layer on the Object Properties toolbar.
- Using the RECTANGLE command, draw the $6 \times 6$ square shown in Figure 3-8, with the first corner at (3,2) and other corner at (9,8).
  Your rectangle should show the red, continuous lines of Layer 1.
- Click anywhere in the Layer Control box on the Object Properties toolbar.
- Click to the right of the layer name 2.
  Layer 2 becomes the current layer.
- With Layer 2 current, draw the hidden circle in Figure 3-8, centered at (6,5) with radius 2.
  Your circle should appear in yellow hidden lines.
Make Layer 3 current and draw a horizontal center line from (2, 5) to (10, 5).
This line should appear as a green center line.

Click the LWT button on the status line so that it is in the on position.

Make Layer 4 current and draw a vertical line from (6, 1) to (6, 9).
This line should appear as a green center line with noticeable thickness.

Click the LWT button again to put it in the off position.
With LWT off, the linewidth of the horizontal center line is not displayed.

Making an Object’s Layer Current

Finally, we use another method to make Layer 1 current before moving on.

Select the Make Object’s Layer Current tool from the Object Properties toolbar, as shown in Figure 3-9.
This tool allows us to make a layer current by selecting any object on that layer. AutoCAD shows the prompt
Select object whose layer will become current:

Select the red rectangle drawn on Layer 1.
Layer 1 replaces Layer 4 in the Current Layer box.

Other Properties of Layers

There are several other properties that can be set in the Layer Properties Manager, or, more conveniently, in the Layer list box. These settings probably will not be useful to you until later on, but we introduce them briefly here for your information.

On and Off

Layers can be turned on or off with the light bulb icon. On and off status affects only the visibility of objects on a layer. Objects on layers that are off are not visible or plotted, but are still in the drawing and are considered when the drawing is regenerated. Regeneration is the process by which AutoCAD translates the precise numerical data that makes up a drawing file database into the less precise values of screen graphics. Regeneration can be a slow process in large, complex drawings. As a result, it might be useful not to regenerate all layers all the time.

Freeze and Thaw

Frozen layers are not only invisible, but are ignored in regeneration. Thaw reverses this setting. Thawed layers are always regenerated. Freeze and thaw properties are set using the sun icon, to the right of the light bulb icon. Layers are thawed by
default as indicated by the yellow sun. When a layer is frozen, the sun icon is replaced by a snowflake.

**Freeze or Thaw in Current Viewport**

The sun icon freezes or thaws layers in all viewports. Next to the sun icon is an icon with a sun and a square. The square represents a drawing viewport. Viewports are introduced in Chapter 6. This setting is off by default. It allows you to freeze a layer in the current viewport while leaving it thawed in other viewports.

**Lock and Unlock**

Next is the lock icon. The Lock and Unlock setting does not affect visibility, but does affect availability of objects for editing. Objects on locked layers are visible, but they cannot be edited. Unlocking reverses this setting.

**Deleting Layers**

You can delete layers using the Delete button in the Layer Properties Manager dialog box. However, you cannot delete layers that have objects drawn on them. Also, you cannot delete the current layer or Layer 0.

### 3.6 Editing Corners Using FILLET

<table>
<thead>
<tr>
<th>GENERAL PROCEDURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Type f, select the Fillet tool from the Modify toolbar, or select Fillet from the Modify menu.</td>
</tr>
<tr>
<td>2. Type r for radius.</td>
</tr>
<tr>
<td>3. Enter a radius value.</td>
</tr>
<tr>
<td>4. Select two lines that meet at a corner.</td>
</tr>
</tbody>
</table>

Now that you have a variety of linetypes to use, you can begin to make more realistic mechanical drawings. All you need is the ability to create filleted (rounded) and chamfered (cut) corners. The two work similarly, and AutoCAD makes them easy. Fillets can also be created between circles and arcs, but the most common usage is the type of situation demonstrated here.

We only work with the square in this exercise, but instead of erasing the other objects, turn them off, as follows:

- If you have not already done so, set Layer 1 as the current layer.
- Open the Layer list on the Object Properties toolbar, and click the light bulb icons on Layers 2, 3, and 4 so that they turn from yellow to gray, indicating that they are off.
- Click anywhere outside the list box to close it.

When you are finished, you should see only the square. The other objects are still in your drawing and can be recalled anytime simply by turning their layers on again.
We use the square to practice fillets and chamfers.

1. Type f or select the Fillet tool from the Modify toolbar, as shown in Figure 3-10.

   Fillet is also on the Modify menu, but the alias or the toolbar selection is quicker. A prompt with options appears as follows:

   **Current settings: Mode=TRIM, Radius=0.50**

   **Select first object or [Polyline/Radius/Trim/Multiple]:**

   **Note:** As mentioned previously, we show the Modify toolbar in horizontal, floating position. Yours is probably in vertical, docked position as usual.

   Polylines are discussed in Chapter 9, but we have something to show you about this option in a moment. Trim mode is discussed at the end of this exercise.

   The first thing you must do is determine the degree of rounding you want. Because fillets are really arcs, they can be defined by a radius.

   1. Type r.

      AutoCAD then prompts

      **Specify fillet radius <0.00>:**

      The default is 0.00.

   2. Type .75.

      You have set 0.75 as the current fillet radius for this drawing. You can change it at any time. Changing does not affect previously drawn fillets.

      The prompt is the same as before:

      **Select first object or [Undo/Polyline/Radius/Trim/Multiple]:**

      Notice that you have the pick box on the screen now without the crosshairs.

   3. Use the pick box to select two lines that meet at any corner of your square.

      Behold! A fillet! You did not even have to press Enter. AutoCAD knows that you are done after selecting two lines.

   **The Multiple Option**

   We use the Multiple option to fillet the remaining three corners of the square. Multiple allows you to create multiple fillets without leaving the FILLET command.

   1. Press Enter or the spacebar to repeat FILLET.

   2. Type m for the Multiple option.
Select two lines to fillet another corner.
You do not have to enter a radius value again because the last value is retained.
Proceed to fillet all four corners.
When you are done, your screen should resemble Figure 3-11.
Press Enter to exit FILLET.

Trim Mode
Trim mode allows you to determine whether you want AutoCAD to remove square corners as it creates fillets and chamfers. Examples of fillets created with Trim mode on and off are shown in Figure 3-12. In most cases, you want to leave Trim mode on. To turn it off, enter FILLET and type t for Trim and then n for No Trim.
3.7 Editing Corners Using CHAMFER

**GENERAL PROCEDURE**

1. Select the Chamfer tool from the Modify toolbar, or select Chamfer from the Modify menu.
2. Type `d` for the Distance option.
3. Enter a chamfer distance.
4. Enter a second chamfer distance or press Enter for an even chamfer.
5. Select two lines that meet at a corner.

The CHAMFER command sequence is almost identical to the FILLET command, with the exception that chamfers can be uneven. That is, you can cut back farther on one side of a corner than on the other. To do this, you must give AutoCAD two distances instead of one.

In this exercise, we draw even chamfers on the four corners of the square. Using the Polyline option, we chamfer all four corners at once. We also take the opportunity to use a new shortcut menu.

 grote{ Select the Chamfer tool, as shown in Figure 3-13.

 AutoCAD prompts:

(TRIM mode) Current chamfer Dist1=0.00, Dist2=0.00

Select first line or

[Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:

You can type a letter to select an option, but there is also a shortcut menu.

grotere{ Right-click anywhere in the drawing area.

This opens a shortcut menu with the Polyline, Distance, Angle, Trim, mEthod, and Multiple options in the middle panel.

grotere{ Select Distance.

The next prompt is

Specify first chamfer distance <0.00>:

grotere{ Type 1.

AutoCAD asks for another distance:

Specify second chamfer distance <1.00>:

The first distance has become the default and most of the time it is used. If you want an asymmetric chamfer, enter a different value for the second distance.
Press Enter to accept the default, making the chamfer distances symmetrical.

At this point, you could proceed to chamfer each corner of the square independently. However, if you have drawn the square using the RECTANGLE command, you have a quicker option. The RECTANGLE command draws a polyline rectangle. Polylines are discussed in Chapter 9, but for now it is useful to know that a polyline is a single entity comprised of several lines and arcs. If you have drawn a closed polyline and specify the Polyline option in the CHAMFER or FILLET commands, AutoCAD edits all corners of the object.

Type p or open the shortcut menu and select Polyline.

AutoCAD then prompts

Select 2D polyline:

Answer the prompt by pointing to any part of the square.

You should have four neat chamfers on your square, replacing the fillets from the previous task. Your screen should resemble Figure 3-14.

3.8 Using the ZOOM Command

**GENERAL PROCEDURE**

1. Type z or select the Zoom tool from the Standard toolbar.
2. Enter a ZOOM method or magnification value.
3. Enter values or points, if necessary, depending on choice of method.

The capacity to zoom in and out of a drawing is one of the more impressive benefits of working on a CAD system. When drawings get complex, it often becomes
necessary to work in detail on small portions of the drawing space. Especially with a small monitor, the only way to do this is by making the detailed area larger on the screen. This is done easily with the ZOOM command.

You should have a square with chamfered corners on your screen from the previous task.

We demonstrate zooming using the Window, All, Previous, and Realtime options.

Type Z or select the Zoom Window tool from the Standard toolbar, as illustrated in Figure 3-15.

The prompt that follows includes the following options:

Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/Window] <realtime>:

If you have used the Zoom Window tool, the Window option is entered automatically. As in ERASE and other edit commands, you can force a window selection by typing W or selecting Window from a shortcut menu. However, this is unnecessary. The windowing action is automatically initiated if you pick a point on the screen after entering ZOOM.

Pick a point just below and to the left of the lower left-hand corner of your square (point 1 in Figure 3-16).

AutoCAD asks for another point:

Specify opposite corner:
You are being asked to define a window, just as in the ERASE command. This window is the basis for what AutoCAD displays next. Because you are not going to make a window that exactly conforms to the screen size and shape, AutoCAD interprets the window this way: Everything in the window will be shown, plus whatever additional area is needed to fill the screen. The center of the window becomes the center of the new display.

- Pick a second point near the center of your square (point 2 in the figure).
  AutoCAD will zoom in dynamically until the lower left corner of the square is enlarged on your screen, as shown in Figure 3-17.

- Using the same method, try zooming up further on the chamfered corner of the square. If Snap is on, you might need to turn it off (press F9).
  Remember that you can repeat the ZOOM command by pressing Enter or the spacebar.
  At this point, most people cannot resist seeing how much magnification they can get by zooming repeatedly on the same corner or angle of a chamfer. Go ahead. After a couple of zooms, the angle does not appear to change, though the placement shifts as the center of your window changes. An angle is the same angle no matter how close you get to it, though what happens to the spacing of the grid and snap as you move in?
  When you are through experimenting with window zooming, try zooming to the previous display.

**Zoom Previous**

- Press Enter to repeat the ZOOM command, or select the Zoom Previous tool, as shown in Figure 3-18.
- If you repeated the command by pressing Enter, type p.
  You should now see your previous display.
  AutoCAD keeps track of up to 10 previous displays.
3.9 Zooming and Panning with the Scroll Wheel

GENERAL PROCEDURE

1. Click the scroll wheel forward to zoom in and back to zoom out.
2. With the scroll wheel pressed down, drag the image on the screen to pan.

AutoCAD 2006 has new options for zooming and panning using the scroll wheel on your mouse. Zooming in this manner is very convenient, but less precise than using the ZOOM command. You occasionally get unexpected results. On the other hand, panning with the scroll wheel works just as well as using the PAN command and involves fewer steps.

Zooming with the Scroll Wheel

In AutoCAD 2006 each click of the scroll wheel will cause a 10% magnification or reduction of the image in your drawing area. Clicking forward (away from your hand) will cause you to zoom in. Clicking back (toward your hand) will cause zooming out. Notice that clicking forward after clicking back does not exactly reverse the zoom. The 10% factor is always applied to the current view, so that clicking back after clicking forward will leave you with a slightly reduced image. (For example, your first zoom in will take you to 90% of the original view. The next zoom out will take you out by 10% of 90% and you will now be at 99% of the original view.) Also, when you use the scroll wheel to zoom, AutoCAD uses the position of the crosshairs to determine the line of the zoom, so you can get very different zooms from different crosshair positions. This can get a little unpredictable. You will have better control if snap is on and if you don’t move the cursor too much between zooms. Try it.

✦ Check to see that the Snap button is in the down position.
✦ Place the cursor near the center of the chamfered square and click the scroll wheel one click forward.
  Your screen image will be enlarged by 10%.
✦ Click another click forward.
  Your screen is further enlarged.
✦ Click one click back.
Click another click back.
Notice that your current image is slightly smaller than your original view.

**Panning with the Scroll Wheel**

Panning with the scroll wheel is even easier than zooming and does not create any of the mathematical or other unexpected results encountered with zooming. To pan, press the scroll wheel down, just as you would press down on either of the mouse buttons. When the wheel is down you can drag your screen image around. It will continue to follow your cursor until you release the wheel.

- Position the crosshairs near the middle of the screen and press the scroll wheel down.
  
  The grid will disappear and the realtime scroll icon, which looks like a hand, will appear.
- Hold down the scroll wheel and move the cursor diagonally up and to the right, as illustrated in Figure 3-19.
- Release the pick button to complete the PAN procedure.
  
  Try it again.
- Press the scroll wheel and drag the image back near its original position.

In a moment we will explore AutoCAD’s realtime ZOOM and PAN features. You will find that panning with the scroll wheel is very similar to realtime PAN. But first, let’s go back to where we started.

**ZOOM All**

This is the option we have been using to enlarge our grids since Chapter 1. ZOOM All zooms out to display the whole drawing. It is useful when you have been working in a number of small areas of a drawing and are ready to view the whole scene. It also quickly undoes the effects of zooming repeatedly with the scroll wheel. You do not want to have to wade through previous displays to find your way back. ZOOM All takes you there in one jump.

![Figure 3-19](image-url)
To see it work, you should be zoomed in on a portion of your display before executing ZOOM All.

- Use the scroll wheel or the ZOOM command to zoom in on a window within your drawing.
- Press Enter or type z to repeat ZOOM again.
- Type a for the All option.

*Note:* The Zoom Window tool also has a flyout that includes tools for all the ZOOM command options, including ZOOM All, as shown in Figure 3-20. Flyouts are toolbar features that make additional tools available. Any tool button that has a small black triangle in one corner opens a flyout. To open a flyout, hold down the pick button while the arrow is on the tool. Then run down or across the flyout to the tool you want. When the tool button is down, release the pick button.

### 3.10 Using Realtime ZOOM and PAN

**GENERAL PROCEDURE**

1. Pick the Pan Realtime or Zoom Realtime tool from the Standard toolbar.
2. Use the cursor to move objects (PAN) or increase or decrease magnification (ZOOM).
3. Press Enter or the spacebar to exit the command.

Like the scroll wheel, realtime ZOOM and PAN allow you to see changes in display and magnification dynamically as you make adjustments. As soon as you start to use ZOOM, you are likely to need PAN as well. Whereas ZOOM allows you to magnify portions of your drawing, PAN allows you to shift the area you are viewing in any direction. You also have the option of panning with the scroll bars at the edges of the drawing area, but the PAN command provides more flexibility. In particular, it allows diagonal motion. We use the Pan Realtime tool first and then the Zoom Realtime tool.
Type p or select the Pan Realtime tool from the Standard toolbar, as illustrated in Figure 3-21.

With either method, you see the PAN command cursor in the form of a hand icon, with which you can move objects on the screen. When the mouse button is not depressed, the hand moves freely across the screen. When you move the mouse with the pick button held down, the complete drawing display moves along with the hand. This action is similar to panning with the scroll wheel, but you are dragging with the left button instead of the wheel.

Move the hand near the middle of the screen without holding down the pick button.

Hold down the pick button and move the cursor across the screen.

Release the pick button to complete the PAN procedure.

Experiment with Pan Realtime, moving objects up, down, left, right, and diagonally. Watch the scroll bars respond as you pan across the drawing area.

**Realtime Zoom**

When you are in either the ZOOM or PAN command, you can access a shortcut menu by right-clicking anywhere on the screen. Try it.

Without leaving PAN, click the right button on your mouse.

This opens the shortcut menu illustrated in Figure 3-22. This menu allows you to switch quickly between realtime PAN and realtime ZOOM.

Select Zoom from the shortcut menu.

The menu closes and the realtime ZOOM cursor appears. As illustrated in Figure 3-23, this is represented by a magnifying glass with a plus (+) sign above and a minus (−) sign below.
Without pressing the pick button, move the Zoom cursor near the bottom of the screen.
   As with the Pan cursor, you are able to move freely when the pick button is not held down.

Press the pick button and move the cursor upward.
   With the pick button pressed, upward motion increases magnification, enlarging objects on the screen.

Move up and down to see the effects of the Zoom cursor movement.

Release the pick button to complete the process.
   When you release the button, you do not exit the command. This is important because it might take several trips up or down the screen to indicate the amount of magnification you want. Moving the cursor halfway up the screen produces a 100% magnification.

Continue to experiment with realtime ZOOM and PAN until you feel comfortable.

To exit, press Esc, the spacebar, or Enter.
   You can also right-click to open the shortcut menu and then select Exit.

Transparent Commands

If you have used the toolbar or the menu to enter the ZOOM and PAN commands, you might have noticed that they place an apostrophe and an underline before the name of the command. If you select the Pan tool, for example, you see the following in the command area:

Command: '_pan

The apostrophe is a command modifier that makes the command transparent. This means that you can enter it in the middle of another command sequence, and when you are done you are still in that sequence. For example, you can pan while drawing a line. This is convenient if you already have selected the first point and then realize that the second point will be off the screen. A sample procedure using transparent PAN would go as follows:

1. Type l or select Line.
2. Pick a first point.
3. Type ‘p (notice the apostrophe) or select the Pan tool.
4. Move the display as you wish.
5. Exit PAN.
6. Pick a second point to complete the line.

The underline character (_ ) you see after the apostrophe and before many commands that AutoCAD sends to the command line is added to commands in menu systems to ensure that AutoCAD interprets the commands in English. Foreign-language versions of AutoCAD have their own command names, but can still use menus developed in English, as long as the underline is there as a flag.
3.11 Using Plot Preview

**GENERAL PROCEDURE**

1. Type Ctrl+P, select the Plot tool from the Standard toolbar, or select Plot from the File pull-down menu.
2. Change parameters as needed.

Plot preview is an essential tool in carrying out efficient plotting and printing. Plot configuration is complex, and the odds are good that you will waste time and paper by printing drawings directly without first previewing them on the screen. AutoCAD has previewing tools that help you know exactly what to expect when your drawing reaches a sheet of paper.

In this task, we are still significantly limited in our use of plot settings, but learning to use plot preview makes all your future work with plotting and printing more effective. As in Chapter 2, we suggest that you work through this task now with the objects on your screen and refer to it as necessary after you have done any of the drawings at the end of this chapter.

- To begin this task you should have objects or a drawing on your screen ready to preview.
- If you are using the objects drawn in this chapter, turn all layers on using the Layer list on the Standard toolbar.
- Type Ctrl+P, or select the Plot tool from the Standard toolbar or Plot from the File menu.

This opens the Plot dialog box, familiar from the last chapter. The Preview button is at the bottom left of the dialog box. The button will call up a full preview image of your drawing on a sheet of drawing paper. Without going to a full preview, however, you already have a partial preview in the Printer/plotter panel. It shows you an outline of the effective plotting area in relation to the paper size, but does not show an image of the plotted drawing. This preview image will change as you change other plot settings, such as plot area and paper size. Let's look at a full preview.

**Note:** We address paper sizes in the next chapter. For now, we assume that your plot configuration is correctly matched to the paper in your printer or plotter. If you do not get good results with this task, the problem might be in this area.

- Check to see that a plotter or printer has been selected in the Printer/plotter name box. If not, select one now.

The Preview button will not be accessible if you have not chosen a plotter.

- Click the Preview button.

The dialog box disappears temporarily and you see a preview image similar to the one in Figure 3-24. This image represents your drawing on paper as it is...
Part I  Basic Two-Dimensional Entities

now configured for printing. The ZOOM Realtime cursor appears to allow you to zoom in or out on aspects of the preview. By clicking the right button, you can access the Zoom and Pan shortcut menu demonstrated earlier in this chapter. The scroll wheel also works here for panning and zooming. Panning and zooming in the preview has no effect on the plot parameters. You might want to experiment with this feature now.

✦ When you are done experimenting with Zoom and Pan, press Esc, Enter, or the spacebar to return to the Plot dialog box.

This ends our initial preview of your drawing. In ordinary practice, if everything looked right in the preview, you would move on to plot or print your drawing now by preparing your plotter and then clicking OK. In the chapters that follow, we explore more features of the Plot dialog box and use full and partial plot previews extensively as we change plot parameters. For now, get in the habit of using plot preview. If things are not coming out quite the way you want, you can fix them soon.

✦ To save your settings, including your plotter selection, click the Apply to Layout button.

✦ Click OK to plot or print your drawing, or click Cancel to exit without printing.

Figure 3-24
Using the Plot Preview Tool

AutoCAD also has a Plot Preview tool on the Standard toolbar, as illustrated in Figure 3-25. This icon is similar to the Preview tool in other Windows applications and performs the same function as the Preview button in the Plot dialog box. It gives you a quick look at your drawing positioned on a drawing sheet, but you have to go to the Plot dialog box if you want to make changes in plot configuration. Try it.

1. Click the Plot Preview tool, as illustrated in Figure 3-25.
2. You see a full preview of your printed drawing, as shown previously in Figure 3-24.

**Note:** If you have not saved your settings by clicking Apply to Layout, you will see a message in the command area that says “No plotter has been assigned.” In this case AutoCAD will not show a preview.

### 3.12 Review Material

#### Questions

1. What function(s) can be performed directly from the Layer list on the Object Properties toolbar? What functions can be performed from the Layer Properties Manager?
2. What linetype is always available when you start a drawing from scratch in AutoCAD? What must you do to access other linetypes?
3. How many colors are available in AutoCAD’s Index Color system? What are the other color systems that are available in the Select Color dialog box?
4. How many different layers does AutoCAD allow you to create?
5. Name three ways to change the current layer.
6. You have been working in the Layer Properties Manager, and when you return to your drawing you find that some objects are no longer visible. What happened?
7. What is a transparent command? How do you make a command transparent when entering it at the command line?
8. What happens to the grid when you zoom way out on a drawing?
9. Name one limitation of scroll bars that the PAN command does not have.
10. Describe the use of the scroll wheel for panning and zooming.
11. What is the difference between a partial and a full plot preview?
12. What type of preview is created by the Plot Preview tool?
Drawing Problems

1. Make Layer 3 current and draw a green center line cross with two perpendicular lines, each two units long and intersecting at their midpoints.
2. Make Layer 2 current and draw a hidden line circle centered at the intersection of the cross drawn in Step 1, with a diameter of two units.
3. Make Layer 1 current and draw a red square of two units on a side centered on the center of the circle. Its sides run tangent to the circle.
4. Use a window to zoom in on the objects drawn in Steps 1, 2, and 3.
5. Fillet each corner of the square with a 0.125 radius fillet.

3.13 WWW Exercise 3 (Optional)

This time we demonstrate the use of the Web toolbar. Your task is to open the toolbar, use the Browse the Web tool to go to our website, take the test, and then do the Web project. The project for this chapter takes you deeper into the world of CAD on the Internet. The Web is full of interesting and informative CAD-related websites. There are sites maintained by professional journals, CAD newsgroups, CAD industry sites, sites with drawings that can be viewed or downloaded, sites with tutorials, sites with tips on CAD technique, and sites with information on CAD-related software.

Start by opening the Web toolbar using the Toolbars shortcut menu. This is the quickest way to open a toolbar.

✦ Move the cursor so that the arrow is pointing anywhere inside of any of the currently visible toolbars.
✦ With the arrow in this position, right-click.

This opens the Toolbars shortcut menu, shown in Figure 3-26. This long menu includes 29 toolbar selections.
✦ Locate Web near the bottom of the list.
✦ Select Web.

This opens the Web toolbar, shown in Figure 3-27.
✦ Select the Browse the Web tool, as shown.

The Browse the Web tool executes the BROWSER command and automatically enters the default URL.
✦ If you have not made our website the default, navigate to it from your default site, using the address www.prenhall.com/dixriley.

Away you go!
Chapter 3 Layers, Colors, and Linetypes

Figure 3-26

Figure 3-27
3.14 Drawing 3-1: Mounting Plate

This drawing gives you experience using center lines and chamfers. Because there are no hidden lines, you have no need for Layer 2, but we continue to use the same numbering system for consistency. Draw the continuous lines in red on Layer 1 and the center lines in green on Layer 3.

![Diagram of Mounting Plate]

**Drawing Suggestions**

GRID = 0.5  
SNAP = 0.25  
LTSCALE = 0.5

**LTSCALE**

The size of the individual dashes and spaces that make up center lines, hidden lines, and other linetypes is determined by a global setting called LTSCALE. By default, it is set to a factor of 1.00. In smaller drawings, this setting is too large and causes some of the shorter lines to appear continuous regardless of what layer they are on. To remedy this, change LTSCALE as follows:

1. Type lts.
2. Enter a value.

For the drawings in this chapter, use a setting of 0.50. See Figure 3-28 for some examples of the effect of changing LTSCALE.

![Examples of LTSCALE settings]

Figure 3-28
MOUNTING PLATE

Drawing 3-1
3.15 Drawing 3-2: Stepped Shaft

This two-view drawing uses continuous lines, center lines, chamfers, and fillets. You might want to zoom in to enlarge the drawing space you are actually working in, and pan right and left to work on the two views.

![Two-view drawing of a stepped shaft]

**Drawing Suggestions**

- GRID = 0.25
- SNAP = 0.125
- LTSCALE = 0.5

- Center the front view in the neighborhood of (2,5). The right side view will have a starting point at about (5.4,12), before the chamfer cuts this corner off.
- Draw the circles in the front view first, using the vertical dimensions from the side view for diameters. Save the inner circle until after you have drawn and chamfered the right side view.
- Draw a series of rectangles for the side view, lining them up with the circles of the front view. Then chamfer two corners of the leftmost rectangle and fillet two corners of the rightmost rectangle.
- Use the chamfer on the side view to line up the radius of the inner circle.
- Remember to set the current layer to 3 before drawing the center lines.

**3-D Models of Multiple-View Drawings**

If you have any difficulty visualizing objects in the multiple-view drawings in this chapter through Chapter 11, you might wish to refer to the images in Section 14.18 at the end of Chapter 14. These are 3-D solid models derived from 2-D drawings done throughout the book.
Chapter 3 Layers, Colors, and Linetypes

STEPPED SHAFT

Drawing 3-2
3.16 Drawing 3-3: Base Plate

This drawing uses continuous lines, hidden lines, center lines, and fillets. The side view should be quite easy once the front view is drawn. Remember to change layers when you want to change linetypes.

Drawing Suggestions

GRID = 0.25
SNAP = 0.125
LTSCALE = 0.5

- Study the dimensions carefully and remember that every grid increment is 0.25, and snap points not on the grid are exactly halfway between grid points. The four circles at the corners are 0.38 (actually 0.375 rounded off) over and in from the corner points. This is three snap spaces \(0.375 = 3 \times 0.125\).
- Position the three circles along the center line of the rectangle carefully. Notice that dimensions are given from the center of the screw holes at top and bottom.
- Use the circle perimeters to line up the hidden lines on the side view, and the centers to line up the center lines.
BASE PLATE

Drawing 3-3
3.17 Drawing 3-4: Bushing

This drawing gives you practice with chamfers, layers, and zooming. Notice that because of the smaller dimensions here, we have recommended a smaller LTSCALE setting.

Drawing Suggestions

GRID = 0.25  
SNAP = 0.125  
LTSCALE = 0.25

• Because this drawing appears quite small on your screen, it would be a good idea to zoom in on the actual drawing space you are using and pan if necessary.  
• Notice that the two 0.25-diameter screw holes are 1.50 apart. This puts them squarely on grid points that you should have no trouble finding.

Regen

When you change a linetype scale setting you see a message in the command area that says Regenerating model. Regeneration is the process by which AutoCAD translates drawing data into screen images. Regeneration happens automatically when certain operations are performed. You can also force a regeneration using the REGEN command by selecting Regen from the View menu.
Chapter 3  Layers, Colors, and Linetypes

BUSHING
Drawing 3-4
3.18 Drawing 3-5: Half Block

This cinder block is the first project using architectural units in this book. Set units, grid, and snap as indicated, and everything falls into place nicely.

Drawing Suggestions

\[
\begin{align*}
\text{UNITS} &= \text{Architectural precision} = 0' - 0\frac{1}{4}'' \\
\text{GRID} &= \frac{1}{4}'' \\
\text{SNAP} &= \frac{1}{4}''
\end{align*}
\]

- Start with the lower left corner of the block at the point \((0' - 1'', 0' - 1'')\) to keep the drawing well placed on the display.
- Set the FILLET radius to \(\frac{1}{2}''\) or 0.5. Notice that you can use decimal versions of fractions. The advantage is that they are easier to type.
HALF BLOCK

Drawing 3-5
3.19 Drawing 3-6: Packing Flange

This drawing uses continuous lines, hidden lines, center lines, and fillets. The side view should be quite easy once the top view is drawn. Remember to change layers when you want to change linetypes.

**Drawing Suggestions**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNITS</td>
<td>Fractional</td>
</tr>
<tr>
<td>GRID</td>
<td>1/4&quot;</td>
</tr>
<tr>
<td>SNAP</td>
<td>1/16&quot;</td>
</tr>
<tr>
<td>LTSCALE</td>
<td>0.5</td>
</tr>
</tbody>
</table>

- Study the dimensions carefully and remember that every grid increment is 1/8" and snap points not on the grid are exactly halfway between grid points. Notice that the units should be set to fractions.
- Begin by drawing the outline and then the three center lines in the top view. Then proceed by drawing all circles.
- The circles can be drawn using center and diameter. Position the center of the circle where the center lines cross and type in the diameter.
- Use the top view to line up all the lines on the side view.
Chapter 3 Layers, Colors, and Linetypes

PACKING FLANGE
Drawing 3-6